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= To Work With ViewCube Display Options

Control ViewCube settings and with which visual styles it is active.
Show or Hide the ViewCube in the Current Drawing

¢ Click View tab » Viewport Tools panel » View Cube. ‘G ‘ Find

Show or Hide the ViewCube by Visual Style
1. Right-click the drawing area and choose Options.

2. Onthe 3D Modeling tab, under Display Tools In Viewport » Display The ViewCube, click or clear:
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= All Other Visual Styles
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ShowMotion

Provides an on-screen display for creating and playing back
cinematic camera animations for design review, presentation, and
bookmark-style navigation.
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lses the default metric settings.

crosiall (e S danca any s Gale L) die jelay ales can i M ¢ Lucal i) b Y oa yall 138 )
ol LS " e jha (e (V) Aeilll ) "filedia" s "startup”

Command: FILEDIA

Enter new value for FILEDIA <iz: 1

B~ Tvoe o command

& an an AELE jelid "3 ga" Larial o3 "Metric” Jbal) bandi (he S5
auavﬁ‘aévls i) ga
(Drawing1) a=YU "ol siad) Ja p&" & ey Calall ausd o)) ¥ 1 Baa auaad) ans )l Cale pe Jand) fasi Laie
Cale g Ui 3 ye JS 3 LT ol 3y a8 501 138 () 3) el sy e Talie) ¥ 51 Y 51 Y aamdl (55 (o)) oSa)
j CTAENPIV
eH-IJS‘ Cilda g
Gkl (saals 35y 3 "units" eY) A (e (el s g cpa Adlide £l e Joladll slSa) peali pll i o)
—:AgY) Gl

Units se¥!debday ja¥) Hlaw 34 (e -1

EE command entry: units {or 'units for transparent use)

Units 530 lo 8 Gt i) cpn 2 (51 6) s 50) A& 30 -2

8 Menu: Format > Units
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| - \c arch Commans

=]

to maintain the drawing

awing Properties
5et and display the file properties of
the current drawing.

Uniits
Control coordinate and angle display
formats and precision. [}

L

B

=3

n
o
(=]

Audit
Evaluate the integrity of a drawing
and corrects some errars,

[

9 Save As
= Impaort 3

[ Status
1| Display drawing statistics, modes, and
. extents,
= Export 0
Purge
' D Remove unused named items, such as
J = block definitions and layers, from the
% Publish | * priy
@ Print » E Recayes o
-2 | Repaira damaged drawing file,
| Drawing b .
Utilities Open the Drawing Recovery Manager
| Display the drawings that may need to

be recovered after a program or

system failure.
e Close 4 %

| optiens | | Exit Autodesk AutoCAD 2017

oty LS Melan gl ol ) gall anpe el oSled LaYI el

A Drawing Units *
Length Angle
Tvpe: Twpe:
{Decimal P Decimal Degrees ~
Precision: Precision:
0.0000 v (1] w
[ ] Clockwise

Inserion scale
IUnits to scale inserted content:

Millimeters w
Sample Output

15.2.0039.0
3450

Lightirg
|nits for specifying the intensity of lighting:

Imtemational b

Cancel Direction... Help

"PreCiSion" :\".- - “ :dmuj\ du d)&&j‘ 2y “!f: & u&é%‘ 2‘%)'4"‘5 utypell ?‘“’)M Q\J;J II&JJH A:IA;:I Us‘“;
as (0.00) 54l &5 "Precision” Jiall & agull haal"length" o)) siall aad 450 311 5 dudadl) bl
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Sets and controls the limits of the grid display in the current Model or layout tab.

8 Menu: Format = Drawing Limits

EE command entry: limits {or 'limits for transparent use)

" 52 e

Autodesk Al

Home  Insert  Annotate  Paramet %"Layer..‘

'n D . e i gy Layer States Manager...
o if ‘

” = Layer toals =
Line Polyline Ciicle A‘r( - Q Color...

Linetype...

Lineweight...

Transparency

Scale List...

Text Style..,
Dimension Style..,
Table Style...
Multileader Style
Plot Style...

Point Style...
Multiline Style...

Units...
Thickness

OB wNORAMY &

Drawing Limits b
[[I] Rename...

") s 8 "limits" Y il 2
4 glaall 48 ) gl ol aaal ¢ a1 48 ) o) e e (S N Adat agan caldad Al yedai " pa)
S @805 X saall olaily 48,550 Jsha iy S a0 o Gy (¢) Alaldl) Loginy Joaly (el ) dipacny
Y saall oladly 48 5l J gla Jiay

o LS () sSi agitl) @l glad ()8 A3 el sy 48 )5 iy il 1 Jlia

Command: *Cancel®

Command :

Command: LIMITS

Reset Model space limits:

Specifty lower left corner or [ON/OFF] <8.9000,0.0088>:
Specify upper right corner <4208.8088,297.06003:

W - Tvpe o command
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9 |~ Type a command

Y+ (s s saball olai¥ls YAY (5 shu il olad¥) Allal) o3g]

(on) Ui OIS 13 "agaad) 38a" s el odlel 5o (& pacaiall [OH/OFF] <t o gl )
zoA iyl ol Al Gm s e O @bl G 485l 350a # s Jaad cililaa) 6 8
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Command:

Command :

Command: line

Specify first point: 10,250
**Qutside limits

* LINE Specify first point:

EERA]
CSais ¢ "R DA (e ShalSie ans I s (5 AT 58 B2l e 53 Baswie "CAAE" Lo an I o
oasad” 5l "l gl ) "aasaat” Sl "L GEAN" 5l " LB G e Aladin b ) gy iladl) ae Jaladll
.v....:,dg .S... "C)\,S

Menanst sale ) ol Catladll Apens Sah aal gl Y1 8 "Aadd" Ladd saal 5 Aali sale i

B dBdd o L)
Y SO 3kl gaals saaa dadd (L) (S

Button

¥ Ribbon: Home tab » Layers panel » Layer Properties Manager
% Menu: Format » Layer

EE command entry: layer {or 'layer for transparent use)

Page 19 of 122



il Lo il Dlie Y1 A8 phall Jlasins
daadl) jatlbad pae HHll Ao 581 A "Ribbon VgAY "R -l e anl

= Autodesk AutoCAD 2017 Drawingl.dwg

Insert Format Tools' Draw Dimension Modify Parametric Window

Home Insert  Ann Parametric Vi Manage Output Add-ins Featur:

fiw ol
L} .’
A - Y /
Line Palyline Circle A % ‘| a - : Layer
S B B ik &t Properties Za
Draw = dodify ~
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Autodesk AutoCAD 2017 Drawingl.dwg
Draw ]

fanage  Output
A Load or Reload Linetypes

File...

Avyailable Linetypes

Annotation =

Linetype Description s
ACAD_IS002W100 IS0dssh
ACAD_ISO03W 100 IS0 dashspace __ __ __ __ __ __
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+ Annotation Visibility
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Annotation Scale
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Layer Color LineType
Objects White Continuous
Dimensions Red Continuous
Text Blue Continuous
Hatch Yellow Continuous
Center Red Center
Hidden Yellow Dashed
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FER| YTV

3 . BylLayer
Bylaye
fav i es . Clipboard  View
Bylayer

Properties « s Groups ~ -

e

Measure

|
L2 1D Point
P . @
Point Style...
Specifies the display style and size of point objects
e PTYPE
Press F1 for more help

A Point Style X
__IINEIRNI
[o][0][@][][D]
(O] (O] 8] =] [d]
[3][0] e8] (=] (@]

Poirt Size g

(®) Set Size Relative to Screen
() Set Size in Absolute Units

| cncs [ hen

Cal Layer
Ak Properties Zy

Linetype...
Lineweight...

Transparency
f Scale List..,

A Text Style..

¥ Dimension Style...
3 Table Style..

/2 Multileader Style
=¥ PlotStyle..

[ PointStyle...

'_\} Multiline Style...

Units...
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Button

18 mibbon: Home tab » Draw panel » T » Point drop-dewn » Multiple Points

8 Toolbar: Draw H

£ Menu: Draw > Point » Single Point

EE command entry: point
sV Hhll & e Alaiall g aolially dxy V) k) & i
"Ribbon s )" (e 2wl 45y 5l -1
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Toolbars ¥ AutaCAD > Array Edit
fra Command Line ctied " AutodeskSeek > Array_Toolbar
== Clean Sereen Crei+0 EXPRESS > CAD Standards
E Camera Adjustment
= @ - " S Dimension
Line Polyline Circle “hg  Quick Select...
5 & Dimensional Constraints
Draw Order >
Draw
Draw ~ M pdify Isolate 55 : %
= Draw Order
Drawing1* Inquiry &
= Draw Order, Annotation to Front
=% Uprate Fields
Find Text
5 Block Editor Geometric Constraint
Xref and Blocl: in-place Editing > Group
E®  CataBxdraction Inquiry
Data Links > Insert

oLl (aall ToolBar Draw aw ) 314] Jay p& jelasd

. . OV el Say 4ia g
ol S gall) "ad) 8" Loy ) (35 ya e ¢ ARG 4G ) -3

Home Insert Annotate Parametric  View  Manags

© - 0 JE

a- %
Line Polyline Circle  Arc ® ‘|k " / Ray
i  E- KR 8 a2 e Censtruction Line

Draw ~ Maodify + Multiline
Drawing1* s Polyline

) Wireframe] 3D Polyline
Polygon
Rectangle
Helix
Arc
Circle

Donut

Spline

Ellipse
EBlock

Table...
Point SinglePoint
Hatch... = Multiple Point

Gradient... Divide
Boundary... Measure

Region

Y e £ point Y el R B_AY g dayl 1) 48, Jall -4
+ Gldaadla
Acbball el 3w vie aadad Al sy yualic yiiad Ll 8 Grid"ASedd)" Llas oo calias Lla o2 1
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TONE- A A
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Drawingi* 2 +
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Command: LINE

= LINE Specify first point:

E:Il = LINE Specify next point or [Undo]:
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sthae g LS (S ol Jadll slad) o LBl | gl Adas 2da 5 4800 Ll (1) () s & e
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"Type a command" A4Sl & el g "&.&'.L.ml\ dxlad" )A;\J\ 1T ¢ G gl) s p) JRa slas
MY sl Nie

DS "JAL" AUkl aladiud (Sad) (AT B e "aiioee dadad" Y1 danl ORI - L) Ll 12
(o) AN 2

Caansy s AT HLidly sali yall o il "JAN" ~Uikal) Jaxacal laall ddas aans caldad il Al e 13
paal) il had) a8 L) e "agiioe dakad" el AL
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B Drafting Settings

Pointer Input Dimension Input

Cynamic Prompts

prompting

Drafting Tooltip Appearance...

Snap and Grid  Polar Tracking  Object Snap 30 Object Snap  Dynamic Input  Quic| 1 | »

Enable Pointer Imput Enable Dimension Input where possible

Settings... Settings ...

Show command prompting and
command input near the crosshairs

Show additional tips with command

Help

Options... Cancel

X

oo |

Sethings. . ] J)'j\ L;; )3_:\ a_uu 3% (:.1

Snap and Grid | Polar Tracking | Object Snap| |

Enable Paointer Input

Fointer Input

Settings...

A Pointer Input Settings
Format
For second or next paints, default to:
(®) Polar format

() cartesian format

(®) Relztive coordinates
() Absolute coordinates

Visibility
Show coordinate tooltips:
() As soon as 1 type coordinate data
(®) When a command asks for a point

() Always -even when notin command

Cancel Help

2

Hhisa LAt Sl all a ye selad

Tageay "Agpadl)” i ARl Y & Sudiall JAY) S and 13 el e A e S

um‘u ji "‘QJ',-.GJ&\ QQ:\.\A\J‘"
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) Absolute(X1, Y1), (X2, Y2) 4alaal) cibfilaay)
a3 AN ) shadll Dliad ans I A gl Jua1 Ay e dgladl) Lgallan) Gl e Laliill ppen (ol Led

wint or [I_||1|j|::]:
Specify next point or [Undo]: 158,158

Specify next point or [Close/Undo]:

SN 57 - Typ= a command

(AX,AY) ¢(X1,Y1) douil) cililany)
aadill (e Adais JS 2ed AV Lla) 8L (ol 5 "ARlaal) ddpal)” o V) Adaiil) clilaa) (%l g
(ol al )aie) Led dail)
Al A8 )"y i) afiveal) Jindad an 3 45V shall
Command: LINE
Specify first point: 108,166
Specify next point or [Undo]: @58,8
Specify next point or [Undo]: [@e,58
Specify next point or [ClosefUndo]: *Cancel*

Polar(X1,Y1) (L<cr) 4zl cililaay)

e Ay gl )y cpidaiil) A8 AV A Adadill (ol 5 "ARlaall Adpall” L 35N Adadill (o ye L
Odlial) cpihagill (o pmal) andiisal)

MAgaladl) A8y plal)" o i) Al ekl s 53 45Y) <l ghaal)

Specify next point or [Undo]: @58<98@

Specify next peint or [ClosefUnde]: *Cancel®

W ¥~ Type o command

<Uaadla
Jads "ddlhal) ddpall” o Y ddadill (o jat @
Aabia) Lalil) Ciy o3 aie clilaa DU Akl ) 51 o 7 el (Sa) e
sUadY) Cu g
AV Gkl san) oLl (Sad elaal) 038 sl (i gl ¢ Jaad) ol oUad¥) (any clislias 8
Uasll Cuy sl "BackSpace” zlidall anaiul ("JAN" ~likall o Laxiall J8) 025 e jall o) 55 8
oY) Y ey A" Fliad) e dakial o ¢ eYldelda b
oY) 25 oo aal il (U) Caal) aalal el 25 ey
(Undo) <Y bl <l ghadll (e de gama LY
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Line Polyline Circle  Arc = B‘

Draw ~

V) Al ) elai "Ribbon da el e B 5 5y Lkl oY) dail

u * CIRCLE Specify center point for circle or [3P 2P Ttr (tan tan radius)]:
‘;QJA:K:‘)SS\ Q\J\.t;“wd\.cwéc&}ﬁ;ﬁduj\ 0l

il S pa daaad
;@‘J\Mu)\)@_gz@mu}@zm\ ﬁy%y&ﬂ\h%&iﬂ\&&m%qﬁm

CIRCLE

Specify center peint for circle or [3R/2P/Ttr (tan tan radius)]:

£ A = CIRCLE Specify radius of circle or [Diameter]:

okl Ay 5 yilall Cay el (d) delaks f 3 il kil Caiai apassi Uia (S
Diameter

Radius
Enter a value, or specify a second point.

Enter a value, or specify a point.
For example: For example:

//Ji-.- i B e
.r“, \ / k
1 ke T",

1 f
I
E

3p s 35 ANy 630l iy

Specify third point on circle:

DN 55 - Typs o command

I'.\ /I

—
3p 3

S0 Jaaa e add Sl EOBEN L8l (e Basd g i et a8 e JS A
2p (ki ANy 3 ydlal) iy o

el LAl 138 2w die | yladll Al ilads (o SEGS cpidadiy 5 ilall ol Allal) o2a

poir

solany) ol )

Specify second end point of circle's diameter:

VRN 57| - Type a command
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G sana edal LAl e 2% de a3ae Hhd Caialy i liRe au (aie (el Cuny 5N ol S 4
Ay Jala )
nter point for circle or [3P
int on object

Specify point on eobject for second tangent of circle:

Specify radius of circle <327.6211>:

O (5| - Type o command

Jlia
(1) dsall ansy) 1
(ttr) oo DAl LA Lete A5 "B JeY) 2
aisall o ks jial Al Al )l e o(edama e ddadi aaat) 3 yslall sl VAL xe 3
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p Specify Ti poir

EOCN 30l ~ Type o command -
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AV el el 5 s vie | () ASaS) S ye 5 (D) e kil

Command: _donut

Specify inside diameter of donut €23@.5431>:
Specify outside diameter of donut ¢452.9968%:

i ‘\ = DONUT Specify center of donut or <exit::

inside —

diameter 6 ] 0 2

r an
e \ Y 4

diameter

AN Al )l vie Wb syl phadl) i dad gl s (Y ALl die (L) Al aodal Aieias 03 aus )]
Al ) die sl phall dady Y1 Al xie Ll Jalal) jhdll dad adals dieas Ayl L)
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donut
—oonuts

filled rings solid-filled circles
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— distance
P

~——midpaint of first
axis

first axis as major axis

— distance

/T

major axis

mimor axis

first axis as minor
axis

) JS&d)

s (S 2By i) e (S B JGY) sl (eladl 5 Jsha) (phadat Al g 5V ikl
i g 38 yal) (g Adlesall ) Jasm) aad s 4ie 3y W) (g gumnl) JSAI e Adais Jid Y 43NN ddaa)
(bl S s Gt N 58 (6% 8) S saall Ales

Rotation

Creates the ellipse by appearing to rotate a circle about the

first axis.

Specify rotation around major axis: Specify 3 poin? (3), or

gnter an positive angle value less than 90

Mowve the crosshairs around the center of the ellipse and

click. If yvou enter a value, the higher the value, the greater
the eccentricity of the ellipse. Entering O defines a circular

ellipse.

3

C D

ellipse by rotation

rotation_<Y!

¢ el e 400 see G Hlatl) Adads Gl NE glia e Aa g pe 8010 (e S Mg guand)” () Ca g paall
Sl bl dlais Jae 4515 Jidh Ua (rotation) desll | s gaan IS 50l sela ) @lld ol Lpila
(Do) S8 mua sl [sOcCirCle £ 3a 30 g2l ) (5 gimsall

i A sl oy dishall sl () sae AV Ay 28 o4 g gl JS) i ) dal Y] AN
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Draw =

54 Chair*

"Ellips"_"2)"Draw" 4d) (1
Autodesk AutoCAD 2017 Drawing.dwg
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Insert  Annotate  Parametric M f: Modeling
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i
Line Polyline Circle  Arc

e- % I ¢ P
];[ = i Construction Line
Multiline

Palyline
3D Polyline
Palygon
Rectangle

Helix

T MOORL

Arc

Circle

Donut

Spline

w! Ellipse [}3 ¥ Center
Block » < Axis, End

V) Al ) el

xis endpoint of ellipse or [Arc/Center]:

Iy snall 39 dleal) ddads ayaa (bl
e 8 o) ) Y1 Sl 8 Y saall Y1 Al ddad clilaal deliday Ll () 5S5 eliglain) -2
Y1 small 369 Al Aads g alilanl au ) ddlaia o glee (1Sa
AV Al edain J W) llall Alain) oy

Specify other endpoint of awis:

JsY) saall Al lel) Al dans lla
Sle O sl saY) sl (8 U saall AN el ddas laad delay Lal ()5S elidaind -3
Y saall Al Al Adas g ASllan) aw ) dikaie o sles lSa
Y Al ) jedais JY) llall Bty day

Specify distance to other axis or [Rotation]:

@&\JM\&J&)&JJJ‘WJN\M&M&\.J..p..\'éjm\cﬂ); -4
3
YD
B |

ellipse by axis endpoint
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(Lsaall Jsb oaday e cana) (53 ) Gt )l ) saall g8 Y1 saall (35S0 o) (S
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"rotation" = Al

rotation &l JLAl
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(Isocircle) amaa a3 2
plasid e |35le LAl 138 ()5S  Jundl) pasmal) pus ) Lo 8 pns o 55303 o) LA I o2
AEY) G sadll A i ge LS 5 "Snap" e Y) (e "Style" o= Al LAl
B3 oy ala 38 1
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Command: SNAP

Specify snap spacing or [ON/OFF/Aspect/Legacy/Style/Type] <10.8088>: s
Enter spap grid style [Standard/Isometric] «S»: i

Specify vertical spacing <10.8808>:

ED MM 5|~ Tz o comand

sl el A Bl o Jan Sl "gri] ASpAl)" el

(1) 5 5hall 3 el sall JSA ans )5 "line” oY) 3

(Top) sstall s siwall e ans Il pravd i all olail it Jaa DU "cprl+e" 4il il Jarucal
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(Left) s (5 siusall e aujlly ol 55all o) jias Jan 3 "ctrl+e” 4ad 5l Lnanal 10
Lo ) Aa gl Coaia & 4 e s 33¥) 550 S e 238 11

(2) JS e Jomn & e 341 5 ) 1 i A a3 12

() JSEN LS ) e sl (e G e s ) 0 e )1 W) )Y il gladll 57K 13
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"Snap" <Y i 1
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Autodesk AutoCAD 2017 Drawing2.dwg
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Line Polyline Circle  Arc = o i

Construction Line

Draw = if Multiline Layers =

Polyline

3D Polyline
7 Polygon

Rectangle

Helix

Arc

Circle

SR

Chamfer/Elevation/Fillet/Thick fWidth]:

slaiaall S (oS ) Adas S3a

2
X

rot s el e il cul LAl 8 Al Cilial sall o3 ¢ 43l i "dadiiana 1 Cliial sall any Jasa (K4
"daliesa” OIS )Y aladll Jied v :Chamfer

" Jelalea " oy (5 sies Jana :Elevation

" Jaesa "GIS i Gl )52 had Caal (i a3 cFillet

(z oL 0 6Ss clandl) o gan pall" Jubaisa” Lo clon 2085 :Thickness

M ik Iad e 30a3 :Width

Al ie "' Caall delis die D" Judateaa” 3 1sY1 Al paa J A5l cliial sall aaad a3
AV Al jeld a3 "fillet" o Al LAl ey 13g8 Y

Command: _rectang

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: f

Specify fillet radius for rectangles <@. -
OS5 Laa U S © (Sl A (g aadal " Judaeaa” (IS Y () ) sall e Coiai dad aaa allas Alls ) o2
GOSN Adati 3 W) oSl Adads ada " Jadatesa " 3 06 oS I Adad agaa callad ) YY) AL ) ) s
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=

L) L ghadS sale aad%05 Al
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b

C ALl el | 08 Tl Y1 Al

= = XLINE Specify a point or [Hor Ver &ng Bisect Offset]:

Y (s siny osthaall Tl Lgia ey Al Adas paas bl (5 Al Al edas Al e ddads canda 1))
Dot e Al Al e de gana e

&8 ba au ) -:Hor
$asec bl any -Ver
4 3 dear b3 any -1ANg

Ohd (s ) seanall 45 ) 3)) ngjz)usd\aﬁ}\}\Zx{dva'ﬂlasau)g-:Bisect
833 ddlue e ey AT UL (5 ) 59 Jad au y :Offset

- Gl

ommand: _xline

C
Specify a point or [Hor/Ver/Ang/Bisect/Offset]: h
5

pecify through point:

el b Y skl &8 Y dadd) el ASLEN e 3l gl 23a

pecify through point: [@e,3e

5
Specify through point: [@e,3e
5

pecify through point: @e,58

« = XLINE Specify through point:

Lall Ll AoV saisan g Vo 1Y) DA L ghadll o Alialall Adlial) ¢ A8l Lo ghad a )l o Jeasiu
) laall dans eV saisan g 0 Al b al )l
2430 sac Ja sk Ao gens an ) A8Y) ol shadl) ailiy 5eY) 2an i S JA" i) Tkl

Command: _xline

Specify @ point or [Hor/Ver/Ang/Bisect/Offset]: v

- KLINE Specify through point:

a1 sl 8 Y kel a3 ) dadl) s b Aslal e Loddas jal
?pecify thqﬂugh point: @38,8
?pecify thqﬂugh point: [@§549,8
Specify through point: @5@,8
« = XLINE Specify through point:
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dngd Gl Tal) Ld sas g Yo S 5 J oY) 5 adaddl G ALalal) dilisall 230 gae daghad day )l e (s
V5 Gl dasll g ALalal) ddlall Jlall Gll3S g SN Jaall i sas 5 0+ dilse

Mline_<Y

"Draw" il (e "Multiline" j<¥) ia) oty (3l gie (phad s )l "Mline" o) axding

Home Inset  Annotat

= & Jl,ﬂ-"’ - O e

‘ =k - % 0 @A

H' ! ﬂ ;:' ."‘7' Construction Line

Draw Modify % Multiline l}
Drawing?®

Line Polyline Circle  Arc

,_D’ Polyline
By 3D Polyline
\:.r Polygon
I Rectangle
2

Helix

Arc >

AV Al ) jelat

Command: MLINE

Current settings: Justification = Top, Scale = 20.88, Style = STANDARD

LB 8FW - MLINE Specify start point or [Justification Scale STyle]:
A dae @l @l jball aad pa) o Aol Adads 23
GOl sial) Gpladll (g d8Ldll -:Scale
3oL Bl (a3l gl adaddl sy 488 2085 - Justification
O i ¢ SN Taal) Jasi aud gealipal ey o L) N Aeny cosllaall D Badll i aai -:Style
L (o jae aaill 138 (5 0S4
Y] ) phadll aiti A Jad Jaad pLASY
ALl badll Jasi (i 2i ) s a0 edad "Multiline Style" sia)"Format"iaisll (e -1

A Multiline Style x

Current Multiline Style: STANDARD

styes:
lstancarD |
New...
Madify...
Description:
Load...
Save..

Preview of: STANDARD

> A Tk aad oLl )l s a0 pedad a5l 8 a el 138 (4
B Create New Multiline Style >

MNew Style Name: |] |

Start With: [STANDARD

Cancel Help
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Baall lhaill (L&Y "Continue" Ctié.d\ Jazal, aaaldl haall el Laad @L\"Name" Jaall < -2
Jinll 8 el 13¢] Caca s Aella (845 U Lol yualic clical sa lsm au s ek -3
(g 4is) caadll 18) "Description”

B New Multiline Style: AS

x

Description: | |
Caps Elements
Start End Offset Color Linetype
Line: |l |l 0.5 BYLAYER.  Bylayer
Outer arc: |l |l 0.5 BYLAYER.  Bylayer
Innerarcs:  [] Il
Angle: 50.00 50.00 Add Delete
o Offset: {0,500
Fill calor: [ More w
Color: [1 ByLayer v
Displayjoints: D Linetype: Linetype...
Cancel Help

aall &fy cLJjﬂ\(J¢4J=:J\\JA LJL&uat}A_)Auu Ljiai"daia

JS)A‘das.a_u_\ug_mJ\\a\)_

i bad Jaad" ) gal) o je Adand 5 -4

_4;{)&\‘ﬁdaa

sl @i sl 38 5e 3l -5
(Sl Jaaill pLi) Ja Jaas IS Jada) (AU Jad Jaad e S) ety Cue 1)

Arc (w8l

DA s 3k "G al i o) (S
Al &5 AV g a1 3 Points

Y Al jelas el 2aT aie

"ougd" 3 1Y) Akill L) e Leae Jalay ali ) ol Adads Cly e a3 13)

adsdl Jo jal ¥ 8 ) Adail) paaty jeindn Uis WS ("Center” o all JLall AaaiuY (ce) aubal e 8l

[Center/End]:

Specify second point of arc or

AL e oo sllaal

"en" sl ¢3S yall ddati Cay yail M@ me A (Al Ay JERY) l) "o g I Al Adaiall Cay s Lin Sy

Specify end point of arc:

(Aaled) Adads Cay yail

oo sall AN ddadl) uass La Al
4380 A9 59 Algds LN S.EA
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Ay Gl ghdll Alde cuoa el s S

Command: arc

&5 sl sy AL 23

nd point of

o5 sl Al Adai 23
pecify center point of arc (hold Ctrl to switch direc
pecify included angle (hold Ctrl to switch direction): :

AaS pedygly JLEAY g GuiS) r(LhE Caual [ oladl /Ayl 5) il

b o sfll S A 3000 (e Ay Gosthaall ¢ 3adl jlaie sy an) (e godal 5 43S jall 4551 301 i
Ledie 4 glaall 4y 38 yall 4551 31 A o yas Gl o idd JLAY) 8 4y skl oda canaie] @lil Lallda g L

¢ Y1 a8 A slhaal) 45 38 5all Ay ) 30 A Aelida (e 5l el aly 3_pa) B shaal) 340 30 o2 JLA
S8Y1 Iasll (5 ) seanall g LAY o jeda ) A gl 3 A ()5S Le el A i g5 Al i aladiuly
e 5 e a5 Lellan) &y 5 A Al A slase 3NN i g Aglai) Adaii]

okl s Algl g 4l 1 SED

Autodesk AutoCAD 2017 DrawingT.dw
= Modify P 3

Home Inset  Annotate AJBD  Expres

vl 3 o * S 5 —| 1| ‘
X DO®, , : . a

Polyline Circle m ' :_ ’ Layer

Properties =

-
Annotation

& Start, Center, End
Start, Center, Angle

o Start, Center, Length

ot
a ’ Start. End, Radius
+ b Start, End, Direction

= Creates an arc using a start point, endpoint, and a tangent
/

T S A U AL direction at the start point

gl iy 33l oot Liben 58 Cuims el s Bl il (s "G g

AV il shadll s Allall o8 3 5eY) 2aE (S,
Command:
Specify =

&5 sl sy AL 23

25 i) Al A s

pecify center point of arc (hold Ctrl to switch direction) or [Angle/Direction/Radius]: _d

Specify tangent direction for the start point of arc (hold Ctrl to switch direction): 36
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8 Ciatgddleis Ay : SER

2 fz]

radius l\

AN

B

1" |

start, end, radius

Algdy JS a5 4l 1SCE

al~

start{1}, center(2),
and{ 3}

438 0 dag) 39 S 09 4ly 1SCA
'&
,ﬂ—“:.‘ll'\,\ 'I_

NN

starl, center, angle

\

2

Sl Jshg JS g 4l iSCL
—— chord length
1

\&F

start, center, length

(
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dilgs g 49l g 38 1CSE
Vs
A
A,

center(1), start{2),
end(3)

1

L3S daglo Ay S :CSA

—

Q)

iﬂl‘(
[==r 2

center, start, angle

Sl by 4y 38 1CSL

chord length
center, start, length

AnY) Gl gadll A Leaa sin Al g asisall Jad) e gdl) &) el 8 dald Alls cllia
Jﬁi }i a.}ﬁm :\.,Jag e.\.u‘)j "line"‘)A;Y‘ J;-I 1
."arC" U‘“)d‘ fi A;.i 2

Command: ARC

Specify start point of arc or [Center]:enter
L ) o aind) el (e Aasi AT addiey gealil) Jray 55hall oda 3 "JA" Flisd) e hial
ASY) ALl ) sl s sl AS pa a2 aaan ALA o jedaaw 53l daad) (gl

Specify end point of arc (hold Ctrl to switch direction}:

sl JSA e Joanh (o il el AL 33
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Ay Gl gladl) My el 4

Command: LINE

Specify Tirst point:enter

Ay ddats Ll o (gl e ki AT andiiny iyl Jaag 3 9hadll o2a 8 "JRA" Flikd) e L)
Y ALl el A Amlai) Ay ) et iy g AdaE 38 (pa (o sll Luas asiosall as jone g asfiosal

Sl Vsl ) paiasl Uadny JaaMis ALY e 3dais 3ad 5l aisall Jadll Jgla (Jidh Ao delda Ui o
Al 4l Adads ppas allat ) g afisall el Lialall

Specify next point or [Undo]:

-4
" e 5 e il e all (5 Cum Adia s gt e g adad 3 Yl 5003 sy (K4

polygon g3kaY¥) e
A @kl e ) gl (Sad Mg ) 22" paie aw )

B stibbon: Home tab » Draw panel » = > . Polygon

B Menu: Draw » Polygon

) |
ﬁ) Toolbar: Draw ‘—J

E Caomiand enltry pDIfgﬂl’l

M) " s "Polygon")&\ deliba ¢ 3 Al 45 Hlall Jesicin (yad

Command : POLYGON

Enter number of sides <4>: 5§
A sllaall g3 aae il (VY £) ¢ (F) Gn Aaaae dad JIA) L (K4
Specify center of polygon or [Edge]:

S Al aany elaid Fyal Y1 AlAY & 5 abiaal) S e Ak apaad oL

Enter an option [Inscribed in circle/Circumscribed about circle] «I>:

qyg\@iq;;a‘b\uig:g G;}id\d}nﬁqﬁLﬂ\bﬁ@giﬁpe cldaa“gjﬁ c"aﬁAhJ SJﬂJ" - cld:aﬂ A8le aaas L ?¥
& ) adalis alisy Ledaye yay gy 350l Ul ()55 ) camy aliadll ) €(1) adiaall &l Cilbuatiag
9(C) aluaall

Specify radius of circle:
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"Aad gl B EIAl" a8 (ol Al daa

Polygon <3 4 Al &l LAl
st oY) ABAT Al 5 ol ikl aasy aliadl) Cay a3 Edge

Snecifiy 8 poin

Cﬂ}id\C}ABJ;L“Q.L%F&QC;&QA“

: POLYGON
Enter number of sides <5@: 7
Specify center of polygon or [Edge]: e
Specify first endpoint of edge:

Specify second endpoint of edge: [@36,8

au)ﬁh}(/\')u‘)uﬁj\mmw &M\(/\)Lﬁdtjmz\ (».n‘)l-z
Command: -POLYGON

Enter number of sides <7:

Specify center of polygon

_clgbud\‘;SJA idags J;;

Enter an option [Inscribed in circle/Circumscribed about circle] <I::

Specify radius of circle: 48

Page 53 of 122



Pline L shall aaia

SV ALYl s s san s Alalaa Jalah die 223l an )l jualic (L "Line" <Y Ge "hghal) amia" Calia,
23" Lol adll Jsha e <ol i ey Jasha e iy "Line" JeY) ) amoll bd e e b jlandl 41Ky

Command :

Specify

(oA () A (e L )3 L j2 sy o) Sl o) Ja) (b "o ghadl)

SV s dae Al @l LAl e el e (g giad Al ) jedai Al Adad (i ja 2ic
Mo ghadl) aaia" gl ol ) JEBY :Are

"h ghadll amis" 3kt : Close

ball (e Cual AV, "k ghdll aaia" (o 25 ‘Halfwidth

2adll Jghally b d2kd o ) :Length

Shghald) aada" 1 3 ¢ ja jal Gida i) :Undo

(oAl Ay " ghdl) amia" (o 123 :Width

4l ddads oy 123 :End

o ghdll amia e it S i o 4V <) ghal)

PLINE

start point:

o ghadl) aaatia" Ay 2ds

hpec1fy next point or [ﬁrcfHalfwidthfLengtthndﬂindth]:

A Al Jidhe Cum Al Adaii 23a () Sl (o hy s i "l ghdld) adaia" ) s g Al ) o3a
A atosall Aada) A0 ALl st allag ) AN )l sgs patnd | "aghadld) aaaia” (e 151 daaill

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: W

spec

) AL )5\ el "width" e dl) JLall ) QS (w) casall gkl

5 ghadll oda _\ue.ujw@ﬂ\ "l gladl) aaia" Aadad Aol die i jall Aad aaat U o3y
Specify ending width «<9.8888>: 6

jﬁ\a&myﬂ@\w\wh@mwﬂ\wmm

oL 6,.Ux\ ’s)zyn £ 0¥ Y "hghill ania" adad o)

Specify nex

Specify
Specify
Specify
Specify

starting width <6.8800>:

ending width <18.0886>: 3

next point or [Arc/Close/Halfwidth/Length/Undo/Width]:
next point or [Arc/Close/Halfwidth/Length/Undo/Width]:

@ " ghadl) ata" ek

ose/Halfwidth/Ler ":‘_|'|_"._.I'|::|:::_.".'.:'.::|":|'|:: enter
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Solid

Filled <aecas t)\.\a\ Adxia )

solid ey Aty clldg Jasd ¥ v JMA (e 5aY) ) Jgea o)) (S0

Sulaiill |5 5AY) ey 3l gl a1 TG o328 dpaa aliyall callay s Tl ) AV adiaall (g e Al
Adadil) Aayl 1) Akl JS Laiy 1yl 2000 Adadall a5 ZAIGY A0l | & DY aaxie (e Aol ()l ey ol 3V
f V) IS i ge LeS g Ly el Y SYI

GsSE ) (55 a1 Akl apaal e glally il e Lia g gl ) Al ie "JAN" ~Ukall e Jaaal)
S pdimall (b disals AL 20a) 8 pe < Q5 Aagl 1) Adaill e g glally G 1Y) L) Ciaan i
day bl eali ll i asle 5 AUl 5 ) glaall Aaliall oY) Aslal) DK (Al ) 5 AANAN) Ul ksl
elgd) oy 13 5 A Anlisall Za 1) g AN (prilail) JA o) Agaal) Aalisall ey 5 Al Ja) JaSs )
i se LSy il au )l peaie (<G 8 i Lalill aaad (g 5 ol f ORI Zladl e darally Y|

O LA O

¢ 2D Solidsaa¥) Sl Cieas (Hatches yaiedll) paliall any 8 Jin dsgil) S s Fill Y
(WidePolylines (s yall Ja ghaill aaxia

5kas a3 (e e I3 yualinl) Gaxy O
J’/_

Fill mode on

Page 55 of 122



outling px 8 (ze U e &I alinl) axy OFf

‘455‘//_

Fill mode off
al () (Sl damia Ll @S — Ve ) ASS dilie @l dasal — a0 Sy el 13) A0
S e

L) e Jls ASll) basa ) s g e Y 3

Grid behavior
[ &daptive grid

Oy ISl

70

i)

=lil]
-
S

10
&l
33

fmnl
gt
W

qf, =25 oo

100
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Sl Juadl
e—uul\ Q\JSLMJ ‘_'é'..\é.ﬂ\ é‘*"’)ﬂ

el (8 48l el Glaca e aelus ) <l 5aY) (e e gana galiall 5]

485 ) puoll L3S Jsadi G an )l AELE e Ll (e "ASE" G g e Y) 138 ey (Grid ASd)
o ekt Lalal cpe "ASLAN" s3a | Aalall Cuen "ASLAN" Jalis o ALoalall Ailial) e 5 lasd) ey ¢ Ay
[t B (§ ke je¥) A (S Aelidall die 43 )l o jedai Y Jasd A5LAY

: ) dslha Y

s-’l:‘ LS5 " e had die Y aokas Alal) o2 4

W 1. = GRID Specify grid spacing(X) or [ON OFF Snap Major aDaptive Limits Follow Aspect] <18.0a0d>:

AsY) due @Al Ll g gins Al )l o3

A L ghad (g Adlial) Aadll p3a Jiad) A0 dalds oy ddluall dg.aj dnae dad 305 :Grid spacing

(Ao i

L3 e "ASual" el :On

Ll (e "ASEY" o) - Off

a1 13 33aall o ) Aad s A8 Jalis (g Adlisdll avia :Spap

Grid spacing & <©as 130 Diad | Ay gl Leda glad 1) A A Hl ASHEN L glas ) S5 Jav :Major
A U AN da gladll ) €5 ¥ il Ui a5 4y 0 2030 Ja gl o Adlsall LI Y + A
Lad 3aa g Vo o Bacliia 4 ) Lol Loty chlas g Vv o ac e Ay 38 Ja glady AS0E) )@_Lal..us
L

a1 13 IS 138 A0 ET) dn glad 48U ala 3 e GS)A.'J\ 2 die AGA b ghad 43S 10 2% 1gDaptive
ode juladl L8 5aaae LS 380l Jaghad lelal AS 53
o) < display grid beyond limits s& s aDaptive JWia) s seday il e jdll Y Ll
Aol AEl) do gladl) Adlis (pe 8 cililisa i) ASud Jaghad )@_Lu AS g3 gl Jamy gd 4lilad
oda Ou"l):"“hg;\ G..J)A..d\ Ja.ﬂl.dl;bag\_, ):uSdS.uuCJ)A.d\ ;g)slaejﬂ\.nm Lyl 322a4l)
_a)\.ci Dl ‘;EJMMSM\L}L& JL@_L\ AS g3 ) %5&353@&“){\.&)&\

de X, Y Grsaall olail dalisa 0 5S5 A0al Lo ghad o Al o gladl) e "ASE" aus ) tAspect

pecity the horizontal zpacing(X) <&.0088>:

¥. = GRID Specify the vertical spacing(¥) <18.80688>:
(X) Asulll Jalss oy dlalall 488Y) 4Ll ;Horizontal spacing

(Y) 4S8l Lalis (p Abalill 43 5aall d8Lidl) :Vertical spacing
A8V <l shadl) 385 cilas 5 0 Gl e 4808 Jalis (py Adlsal) Jasual 1 QUi

Specify grid spacing(X) or [ON/OFF/Snap/Major/aDaptive/Limits/Follow/Aspect] <A>: 5

On . . Off Aspect
Turns on the grid using

] Changes the grid spacing
the current spacing.

in the X and ¥ directions.

Turns off the grid.

GRID turned on

GRID turned off GRID set to Aspect
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TR By ,E e WG

2\:\44&\2\.&3\3]\MEJMWY\CM\JMUMM\@)&@. Lﬁy‘é&ﬂﬂ‘&@#‘a&&

Ayl
Grid Settings...
- b &
N JJUM\ J\);J\ @)A)@.Jaa SEﬁlngs ‘;Q\JL»A.}‘)SJ\
A Drafting Settings X
Snap and Grid  Polar Tracking  Object Snap 3D Obiect Snap  Dynamic nput  Quic| * |+
Snap On (F9) Grd On {F7)
Snap spacing (Grid style
Srinp K apacind | 10 | Display dotted grid in:
[]20 model space
Snap Y spacing: P{'f [] Block editor
Equal X and Y spacing L] Sreectpond
Grid spacing
Polar spacing Grid X spacing: |5 |
Gnd ¥ spacing: 5
~-— Major line eveny: 3 =
@) Girid snap Grid behawior
(®) Rectangular snap B Adapive gid i )
[] Allow subdivision below grid
() lsometric snap spacing
~ Display arid beyond Limits
ki [ Fellow Dynamic LCS
Cptions ... Cancel Help
G nee s . - - - .. Grid ¥ spacing: 5 . ..
.. n ‘e e Grid * spacing: 5 - ., vl Ve wea nd TRLT
di(X) Jaadl dad yiad aa Jaall ) i al) Juan) Jaadu "ad gaa” ~lidal)

» |7 Gri F7 " I ce e . s L e v
Q& MIGAEON D gl jlaal e KB o) sl o A0l Jalis G 4 gl Al ¢ <38 (y) Jial) da
Al e aal Jaghad jeliis ) sall a ye (3l (38 pa" Lzl

Aalall i Jis U 8 4 slhaall 26 )Y) aadal) 4S80 Lo glad (4 dalia dlald Clilue Lyl

RIPAPAPR PR

" ) sall g ge el i1 Drafting Settings... "d e il) cilabidlal) clalae ) jial o M) gaft Aadldl) yial
LAl Lalas G Adlall Jasal 280 <l ghadll i gLl (S Gl Ml gl g ASud)

+ Gilaadla

ASulll sl g ledal e (F7) zldall

ASul olia) i lelay Alall Loy i b5 ga sl . LA e Lkl 0S4
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‘II

: "Snap<a ¢
Y 138 Apeal muia gl liuae Ba3ae Adluey iy JSG o 0 sSal an )l plise A e o b el (K4
AL (e JiuY) o jall Baal 5 an i) dihie A ydigall s

120.3777, -150.4330, 0.0000

Jids ) B Y oda plia) ol Hledal Sy oS Wil Uiy 2l g pdigall alge ik ae i Hl8 Y1 ol Jaa Dl
Ul e A8 ja a5 o 1A LSAY) ad o) G U Al Ly 33 e e coordinates <LlaaY)
. "Absolute @lhadl" sk ) Lelsad can s "specific gamadall" a8 ldlal) o) S 8 cundl
Wl e i) wie Chaati dasd (Bl 856 AS a mae ) ey Janii Y lilaal) olé glladll skl
el Cpall a5 e eI sl 5 S8l cp skl g Jeadll Sy an ol dikie e Yl
D) le eV BN 5 E (Se ) thad) sl ¢ odled coyshll Wi (e ) a ) el

LAY A0 ) geln )50 As pansal) Al ) glatW) p Jaumia chlilasYy)

Ar )| &l 5 (0 sSy aall 128 B Al HEine A8 pa ae lBlaY] i Baadli "l gl s skl Jeal
el ) Sbsall @ ad ) Jala (s e Calay el die Dl Y] Aal)) 4 el ALl axy Q6 )
Jrains UG o328 Jal Jascally ddadill o3 ie (o gd gl Slaise 05 &l 13) Camiall (e 43 anis (Vv V0 v)
o 50 Gl el By Clilaa o 8 yld) 0S4 AHE il i 54

" Y " e\qslu\:\in

V) Al elsi "Spap” <Y delib e

Command:  SHAP

* SWAP Specify snap spacing or [ON OFF Aspect Legacy Style Type] <1@.8808::

) e il LAl e (s sins Al i 3

o) ddle Jid dp00e dad 2023 :Spacing

gl g2 aalis :0n

il 90 el Off

X, Yinosaall Adlida andy i l) ddlis Javia (Aspect

.(X) i 5l 481 Al :HorizontalSpacing
(Y) 5l A @La) il :VerticalSpacing
285 e Ll o) pau ) pall o 23 5 Al jdsal sl Ol (ad Maxd" Aad "Y" ) et Ll (liad 4l iLegacy
) and el @llin (5l 130 30 Y B el gl (o) (a3 Y e Ll o3l el da gy Y )l
S Y skl Jsan ~land) :Style
ekl ) s 88 A il g gl i Type
1l
AV @l ghadll 385 an ) Cilaa s © Gl o el gl dilie layal

Command: SHAP

- SHAP Specify snap spacing or [ON OFF Aspect Legacy Style Type] <18.@888x:5
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el Jad ez LG

Al el 5 Al () ~lidall il "Aad) Jay a" i"Spap” AalSl o el s A3kl s b

" ",n,«sum

A Drafting Settings

bed

Snap and Grid | Polar Tracking  Object Snap 30 Object Snap  Dynamic Input - Guic) 4 |+

Snap On (F9)
Snap spacing

Equal X and ¥ spacing

Palar spacing

Folar distance:

Snap type
() Grid snap

(®) PolarSnap

Options...

| 3

Grid On (F7)
Grid style
Display dotted grid in:
[ 20 mode! space
[ Block editor
[ ShieetAayout
Grd spacing
Grd X spacing: 10

Grd Y spacing:

Maijor line every:

.

Grid behavior
Adaptive gnd
[ Allow subdivision below grid
spacing
Display arid beyond Limits
[] Follow Dynamic LCS

Concsl | [t

o hs sl 1 e 3l gllaall dileall dpaaell dagal S"eP XsPrcr

Snap Y spacing: 10

- ' Jiall Y

Ay dlall

"o sall K el settings" 4l e | )Ly i)

Jiall b bl

Sizal QUi Jaad "Rl gaa" Al Jaal 5 0 JUia) I3

Jaal) Jt_gs\wfsis _wjmx\ujazﬂm" "ﬂ\"umu)&a(X)dsﬂ\www(Y)dsﬂ\me

» [ Snap On {F9)

ux_musuuy\ 6 2aall e liany “-”L@m"uu\b.. *"‘;?GJ\J\&_,B\J_QQSJ@QLOJS:

_J::.}.;.bﬂ_j(\~~c\~~):\.k§ﬂ\dcc_§_9§)l\

Aalall Cuua Jis IS 8 4 sl a8 Y1 akal 0 ) saal) e ddlia "Gl g il Japal

Caladl " gl g ASuid) Jaa

Polar spacing

Snap type
@ Grd snap
@ Rectangular snap

() |lsometric snap

() PalarSnap
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Caadla

MBall sk clall el e (FO) ikl s
Ml i)y Janid "ANAY) Jay 5" L8 3 sa sdl"Snap” Ukl e daall (Ko e

ol pualic 8 ) o0 g (gl A Gl dad i (K41 e

Orthoalil)
S8 olsn dyg)) laiel e (Alle Jashd an V) L A gee o 4@ boghad sy e 13 ey
Laa Lad o jba Ao 5113 g iy A
"daladl) gk Lii 10N
"aaladll ) gha"olal) :OFF
2 2
1_/_,—’""’ 1

Ortho off Crtha on

‘e
"aalatl) g\t Jasdis e (F8) lidall sy o

elad) ol "aalatll gl Lapsiul Aal) Jay 5 8 3 e sl L) e baaall (K4 e
e
ol paalic b il o go g gl 8 Maatadl) ek ) JEEY) (K e
Akl 4 ) gk
o LSy e Badaa Ll e disall A8 a5 shall 138 ey
AV Al Al jedaia "Adad) Jay y3" _8"Polar” dakl e Liey il 1

Mol Gildial go ad ) sl 4 e edad"Tracking Settings" 4l jia) 2
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£ [ Midpoint 0y [ insertion Clear Al
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Chamfer
Fillet

Blend Curves

3D Operations
Salid Editing
Surface Editing
Mesh Editing
Point Cloud Editing

¥ Change Space
&9 Explode

-45a%a

ST aay ey Rl Jaawdl) al o) i a5 ha¥) el meal) Bpay jealiall apaat Al jela
(:S"dud\" C\_&d\ L;;L&AL: )AL\’J\ A.JA;.\M;)AUA;\.@:\.\Y\ &_\AJ:\.S\;“ 534 ‘59 . ..\;\J eu)),\a.\s %
Bpeay Al el A L aaly ey peaie paad Gl el oY) Gany Ayghaall Gl Jae )
'd.m::\ &_\)M\ e.ua)]\ )4.1.9 .351.333 RPN d;md\ JA‘ .A;.\;\ Alal) o2a ‘;A "Select Object"djs.d\

Page 67 of 122



el sal gl
s all puaiell Cliial ga g JSG judl el 5V 028 adiiu
é Erase
_ié Erase 3\_1}3.1‘}[\ Jax..\ai o..\;m.\ﬂ (NJS\ 3\3)] % 3a2all )ahd\ A\.G}AAA }\ ‘).LA.\d\ " - )AY\ KV e}s.}
ALY Al ) jelat

Command: ERASE

Select objects: all

a0 Cw:&.\u\ u\.m)l\ J}@.b A g ad..jda.iéf— ayall "hg..\?hi" L:J;‘ d}a:u 438 J.u.a.ud\ .de;:i e
WS o e 2ol paiell claia) Jaadud "JEa" CUAA\ Liaal paadll e elgiiW) 2ie (g Al jalie
oy

an |

+— + — —_+ —
W
object selected ocbject erased
+E+ Move
as olaily Aises ddlise Linl 3l g sadsnall jpualiall "aga s o eV 138 o)
r Jla
. Ol (el uad slial JSAN 8 sl gall il ad e i o sllall
3

=T=]
==

1

Lelis Coslhaal) o LusY) o (ki Al ) jedaia 5+ Move 41 A%

) Akl Jie 4Sy jad colhaall dladl) e g ga 6l e )

Y Adadill S ddadi gl s ¢ el janll "dma e AaR st (il Al jelas

Mie el @l jail) Cogllaal) Adaiill i) ¢ A pal) AW Lot 30all ad gl st allat Al el
Y sl

(") Rotate
el allay jualiall aaad aey A e G gd AR Jsa sadaal) anll ualic yah ) 138 g
Ol Al A aad Callay o5 "l 9all dma jal) ABRIN" 3y0a3
"4 gall ¢y) gl A" 2087 :BasePoint
"ol 43905 4a" :Rotation Angle
Badaa Ay g ) I Lelysat o5 Al dallas 4y 5) ) iy ja5 :Reference
2

4%, 4y

object selected base point and angle of result
rotation

Page 68 of 122



Command: LINE

Specify first point: 16,16

Specify next point or [Undo]: @iea,e
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Command: _rotate
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Specify rotation angle or [Copy/Reference] <@>: 28
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Specify second point or [Array/Exit/Undo] <Exit>s: ct any point
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Current settings: Erase source=No Layer=Socurce OFFSETGAPTYPE=8

Specify offset distance or [Through/Erase/Layer] <2.0086r: 8.25
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polar array angle to
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rotated
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Specify second break point or [First podint]:

On B seanall diliall (8 avall o A0 AAT jlad) vie " AGY) ABBI" et aval) paas ddaE )
cadat priladil)
A Ak g 5 "

Seleck ohject:

Specify second break point or [First point]: f

Specify first break point:

Specify second break point:

Ol () seanall ¢ Sal) Caday

before break

after break
z\.haﬂ-a
Al Al ve @ abl & AW ahll A" Sa ¢ Gisa (s i "akE"

T ..

sl il Caal st A g¥1 5 ) ¢ je o)) S5 el 12a 35 Gl ¢ sl pealic ") g g
JOSOY) g dalee 2aavil A0EN 3yl g
Command: FILLET

Current se

Select first object or [UndofPolyline/Radius/Trim/Multiple]: r

AV Al el (1) aakal " i) Lyl Cheal dad il

Specify fillet radius <5.8008:: 5

sthall Hhdll Cuai dad okl

diBaada

5 5tha U emiel) aian3 (5 ik 32 "y g0 b sl (S 13
"OogAl) sl et aant ey Ali B je e

Command: FILLET

Current settings: Mode = TRIM, Radius = 5.8884

Select first object or [Undo/PolylinefRadius/Trim/Multiple]: r

AV Al ) ey Hedaid " oY) an i) jaie” ada
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Select second object or shift-select to apply corner or [Radius]:

roLial a3 xlim g LaS g (Sl 5 lac i "D pudadl” saas U o

first selected object second selected result
object

ddaadla

G528k e 2 (e (B Lagha Y (gl Y g (Ul (S o) ng) Al sl Jashal) Alls
Ol Galadll il Cm Jaai 35000 Cial s yios bl (Y " gail) b Chial dad apaas ) dalall
onhadl) Al alal) Adld) Jiay lady

Al ) edas "Polyline"gc)ﬂ\ LAl pasd die

Select 2D polyline or [Distance/Angle/Method]:

ade Y 2aE o gllaall e gladl) aseta” 23a

o 4] ST _\ll
L I

before after

GlBaada
" agil) Gugd" oLis) aay b ghaall 8 ol ) Cada o st galipdl OIS 1Y) Led ' Trim" Jlad) 23y e
N
(D) (s sbi] " gt} e Ciual" dad Jasay as) g ddads & & o ghadl) Jua i Sa) @

OST cldla calad 1 Y

Chamfer

Bevels the edges of Bbjezts

Calail) Adlise 3yantl oY) G ye oSS allay G Galall e 4y ¢ an )l jualic "l i cildla Cilai"
AU edat 5a¥) 2 ey | Alaal) Sl Al

CHAME

(TRIM mode) Current chamfer Distl = 28.

Select first line or [Undo/Polyline/Dis " od/Multiple]:

Al seds ) g2 sV baall s o8 Tt sadas "Ciladd) Adlu" il 1)

Select second line or shift-select to apply corner or [Distance/Angle/Method]:

3a3aal) wll o "Cill) BA" a3 Gl Ladl) sl s
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first selected line second selected line result

GcJ.d\ sl & Jalaill L;};‘)!\ ) _m;(d) syl C"L‘ U RA TR T I r"‘é e Cue 1)
Al L;;ﬁ\ Calaill Bl maat yldlad oulla J@..E’.'\é”Distance"

ER
(TRIM mode) Current chamfer Distl :
Select first line or [Undo/Polyline/Di cefAngle/Tri ~.Et|'|4:|4:|.-".‘-'1hl‘f:'i|:|lE]': D
Specify first chamfer distance <28.8008>: 38

Specify second chamfer distance <30.8888>;

- A3

Gliblisal) culS 13 L) ¢ S puaiall g J5Y1 juaial) B3 i ag Y A slaia "cihui ddla" cuils 1)
\73.1\.3 Qs )m.\d ua.\a;'j 3_3.1\_:3\ fu\.wd\} YJ\ Qdaall Mm“ jaiad’i ‘QJY\ I uLﬁ ..S

"l ghadl) aaeia" HLd) ali pll llay"Polyline” (oo 8l JLall jLEdl) xie

Select 2D polyline or [Distance/Angle/Method]:

Adee et &5 Y1 el Joled Adlisey JEAY] A (e ol "Aadaliial) Cilblal) Cilad" dplec S5
Aelldl @ jie e olatl "caladd)

Cre A sl 3N A allay o JoY) aall "Caladil) Adlisa” ayaas el Clly"Angle” e dll jLall jlaal xe
Jaal) ¢lld

Specify chamfer angle from the first line <@>: 3@

- chamfer distance
first selected

= ~~____ I
second selected 4," angle

oY o "N lee (o sl any 5230 0 da ghadll A5 o pllaall S 13 Lad ' Trim" sl sda,
(sl s Adle) AV o) (OaiBlsa) AV () oSiu Ja 2 Y i 38 k" Method " Jbal) 23sy

Y elaY) e Jay clilall Galad ) ddaa Sl
e Lines

s Polylines

* [Rays
s Hlines
« 3D saolids

iy Y 4l ( POINES o o e oY) aal a3 5) Jebaitsal) e aipdad 3y 5 @bl Caaay 8
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38 iy Shad Jebadl V5 (Shm ¢ ) il Y Tl oo Sl e (5, 5 43l o ol
Csllaall ayUas 43 ST jua% (38a3 ade J Aglatu ade 138 ey Vg jaad (gl (gmg Y 438 Al

b LSy i) dilie Jled i @l (o yigy Bkt e Yl o) Y

rehill el il (distance) d o o8 DAl Jasiul

D, Dist2 = 29 B

Select first line or [Undo/Polyline/ ance/Angle/Trim Ethu:ud.-'::"-*.ultiple]: i}

Specify first chamfer distance <20.6000>: 306

specify second chamfer distance <38.0000::

Select first line or [Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple]:
Select second line or shift-select to apply corner or [Distance/Angle/Method]:

S ¥ ~ Type & command

BYYY
"JAA" Uil e Jaraally sl eled) 5 "anaadl) cldla” g "AAA aaas V) As )
Adadl ol ) Jaill ladaai o glhaall jualiall mass 4008 Al )
Al jedad el 28T aie
Command: EXTEND

Current settings: Projection=lUCS, Edge=None

elect boundary edges ...

5
5

elect objects on <select all>: 1 found
ek andl ddee olesY "JAAN AU daial byl w3 "clBlal® ) A" soa U o
Al )l
Select objects:

Select object to extend or shift-select to trim or

[Fence/Crossing/Project/Edge/Undo]:

Ll 3aoaal) "Adad)" 1 snaad o glhaall peatall aa

boundary selected objects to extend result
selected

6% Clyiniall (e dad (ol a8 (Adalall 3 3a01) "aaail) ABA" yas (e olgiY) ey ¢ oo Lakddl) b
Aalglad 3aat a5 8 je JS A8 3 ) dead sl )

/=== Trim

Azdad o gllaall ¢ Sall aaad a Al Als all 5 "adall) ABA" yass a Y
Ay @l ghadll a1 il
"Trim"_i2Modify""4alal) (e -1

"Ribbon Ly &ll" L aY) i)l
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cutting edge selected objects to trim selected result
with fence selection
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ALY s ddass die et "ASulall" jB|ock Al
A ol ghadl) 3% "elSudall" ) gels Janiil
% Menu: Tools » COptions (Options dialog box, Profiles tab)

Shortcut menu: Right-click in the command window, or (with no commands active and no
objects selected) right-click in the drawing area, and choose Options.

EE command entry: options

"‘;“Jl:‘i" J\);J\ @J“‘ )@-Eﬁé"options"‘)ﬁ"'TOOIS" :\.A:ilsj\ U‘“ 1
X

A Options
Cument profile <<lnnamed Profile=> & Curent drawing Drawing 1 dwg

Fles Display Openand Save Plotand Publish System User Preferences Drafting 3D Modeling Selection  Profiles  Online

Pickbax size Grip size

Selection modes Grips

MNoun/verb selection Grip Colars...
[] Use Shift to add to selection Show grips

Object grouping
[ Associative Hatch
Implied windowing

[] Mllow press and drag on object

Allow press and drag for Lasso
Window selection method:
Both - Automatic detection ~
Pa— E Object selection limit for display of grips
25000 ‘ Object limit for Properties palstie

] Show grips within blocks
Show grip tips
Show dynamic grip menu
Allow Ci+cycling behavior
Show single arip on groups
Show bounding box on groups

Praview
Selection effect colar; Selection preview
[ Defauit v When a command is active
When no command is active
Fibbon options 4
Visual Effect Settings...
Contextual Tab States Command preview

Property preview

Cancel Apply Help
"selection" u il sl 2

leisl ol "ASalall” Aadle aaa yaa Liayl (KM Showarps el Lags Gies Jaall & 3

J\)ﬂ\ =D LBM "éé\y" CM\ baal 4

LeS 5 ALSH 45 gSall an il jualic apen o "clSalall” jlelay  [Show grps within blocks Jall Lol (e
() ISl 8 i e

T insertion point W 00
-
[l I |
| |
i I ¥
L/
grips within blocks grips within blocks
turned off turned on

s
Clagiinall g yil gall (0 Ao gana g )l .1
BV sl ralSadall ) sk B il gall (gaa) yial 2
sda o) e AYall jaalW) ) i s Jaadlin 3 Al Jama e de ) sal) reilSulallr goa) ) 3
M) e sie A ALl edat s Adadn vl "ASulall"
¥ STREFCH.EF

Specify stretch point or [Base point/Copy/Undo/eXit]:
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baseline
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first dimension ling second dimension
suppressed line suppressed

m  Control the spacing between successive dimension lines in bass
dimensions

1.50

400

r 620
dimension spacing

angular baseline dimensicning linear baseling dimensioning

extension line J‘&Y‘ hjhi

Sl dads

S L el o) 5 alall Jasae s AaDlad) 03a (e " 38 pal) Jaghad" L | gl ) B Al M 38 e AdaR i
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' _P\Luenter mark
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Home Insert Annotate  Parametric  View Manage {’Jﬂplt Add-ins  A360 fatpmssm Festured Apps BIM 360 Performance

A #5F Standard - |'_'| Mystyle - [ 0 s /-O Standard
ind text (et i

A Use Current - e 7
Multiline t: Dimensicn g . 25k |-‘7| H T Center Centerline | Multileader i;a /O
Tt " [A 25 =15 b - Mark /8 7°
Teut = Dimensions = u |  Centerlines Leaders

[— ]I_'I'cp] [2D Wireframe]
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A %% |Standard - |‘_'| Mystyle - E e
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Find text Uze C t - Py
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R |Find text [y Use Current -
Multiline R pimension = W

Text 25 - B -
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To create a radius dimension

1. Click Home tab » Annotation panel » F{eu:lil_ls.l\_/I
2. Select an arc, circle, or polyline arc segment.

3. Enter options as needed:

= To edit the dimension text content, enter t {Text) or m {multiline text).
Editing within or averwriting the brackets (<>} changes or removes the
dimension value, Adding text before or after the brackets appends text
befare or after the dimension walue.

= To edit the dimension text angle, enter a {Angle).

4. Specify the leader line location,

.f.{\"\
£ Toolbar: Dimension I\_/J

EE command entry: DIMRADIUS

RO, 1500

RO.38
A
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Diameter 4 _kill sy
5 ,Ua) Al o e sl Hhad s

To create a diameter dimension

1. Click Home tab » Annotation panel » Diameter.®

2. Select the arc or circle to dimension,

3. Enter options as needed:

s To edit the dimension text content, enter t {Text) or m {multiline text).
Editing within or overwriting the brackets (<>} changes or remowves the

dimension value. Adding text before or after the brackets appends text
before ar after the dimension value.

s To change the dimension text angle, enter a {Angle).

4, Specify the leader line location.

£ Toolbar: Dimension ®

E= command entry: DIMDIAMETER

;90.545 ",/_ 0,545
Angular 45138 )

Ll N ol cpdad o Ay sl ) s
- = = | = @ LR '|{§'}Draﬂing & Annotation v|=!
 Home Insert Annotate | Parametric  View MI g -ﬂmﬂ put  Add-ins

A "‘\B/c Standard = ’4—-‘ Mystyle
Find text ) e Use C t
Multiine A — £ V== curren
Text T [B} 25

: R 1 -
Text « \ 3 r—.‘ i ns =
: Linear
| |
[—1[Top][2D Wireframe]
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i !Angular
fﬁ\rc Length

(\_\:I Radius
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'ﬁ *J‘}T" / ?\\’_ IH”-, "L f /@\ma.?a

(
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specify vertex

Page 87 of 122



Quik Dimension 71 Ay ) slag)
b LS s Ban) 55 e Baae pualind "alan¥1" LY & il 138 aladiul (S

Qdimﬂhﬂ\ Laxal
y - Dl & B B & & - -|{)Drfting & Annotation _~|~ Autodesk AutoCAD 20
LE nsert | Annotate : - Mang Output  Add-ir \360  Express Too
A % Standard - "‘_" Mystyle |
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| |21 EHB oS _Braﬁing&Annntat'son = Autodesk AutoCAD 2017 ch:

Anno{ate

A %% Standard - "‘_" Mystyle -
Find text (el i Use Current - oy
Multiline t; e X & Dimensicn g . m |-_‘;| T Center
Tet ~ [A} 25 5 Mark
s | Centy

Teut =

[-1Top)(2D Wirsframe]

L

base Line
B3l i pa AR e dulie Al o I gu\ o5y Allal) o3a @

-EI- Drafting & Annotation

"‘_" Mystyle b

Annotate

A %5F Standard

Fing fext i UsaC ¢ =
Multiline _ o N Dimencion = IR Use Curren
Teut = |

[~1[Top|(2D Wireframe]
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MTEXT content
Block content
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Center

Dimcen Mark S sall dadle
il gall 5 (el 8O MUELARY ) glaca Ja ghad™ o " 3S sall AaDle " Caviay

OS>

center mark centerlines

CenterMark 4 &= center lines J45! & asail) 4,48
J) ga kS center lines ) (& on dagdl) N ¥ sl J3A (e Centermarkexe ¥ clauda 1)

=

Center
Mark  aY¥) aladiul i CenterMark

255 O center lines ) & off 4wl ) a¥) sl JMA (e Centermarkexe oY) Cilasda 13) Ll
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To control the text style in dimensions

&
Click Horme tab » Annotation panel > iJ » Dimension Style.

In the Dimension Style Manager, select the style you want to change. Click
Modify.

In the Modify Dimension Style dialog box, Text tab, under Text Appearance,
select a text style.

If the current text style does not have a fiked height, enter the height of
dimension text in the Text Height box.

Under Tolerances, enter a height for tolerance walues in the Scaling for Height
bow.

In the Offset from Dim Line box, enter a value for the gap around base
dimension text.

Select a color from the Text Color box,
Click Ok

Click Close to exit the Dimension Style Manager.

% Toolbar: Dimension or Styles

B command entry: DIMSTYLE

"Ribbon" 4l (1« "Dimension Style" bl e Laaally olld 5

Home tab » Annotation panel = iJ » Dimension Style.

"Styles" ) s>l a2 0 el
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A Dimension Style Manager
Cumrent dimension style: Mystyle
Styles: Preview of: Mystyle
A Annotative 28,22
150-25
My Architectural
b
i |
Standard o
1]
List: Description
All styles B &
Dont list styles in Xrefs

| Set Cument
New...
Modify. ..

Ovemide...

Help

Laa e Jaad Cdy ot
2

(Y )l e et "aa Slagl Jaad" Ciy jeil "New" Uik} Lokl

New Style Name:

A Create New Dimension Style

x

Copy of 150-25

| Continue |

Start With:
150-25

[ Anriotative

Use for:

All dimensions

Cancel

e

Aol Jaad cilbial ga iy 25" ) sall o e jedas "Continue"z el haxial &5 aaall M) Jaail Lo aukal

."-\,-J-\%M

A New Dimension Style: Copy of Mystyle

lines Symbols and Amows  Text

Fit Primary Uinits  Atemate Units Tolerances

Dimension Break

Break size:

375 :

Amowheads
First:
# Closed filed L
Second: N
# Closed filed o
Leader:
# Closed filled |
Amow size:
5 L
= Arc length symbol
Center marks (®) Preceding dimension text
() None () Abave dimension text
(®) Mark &5 = O None
() Line Radius jog dimension

Linear jog dimension
Jog height factor;

15 | Text height

Corcd | | Heb
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Lines, Symbols and Arrows (s sl

"3Sal AaMe" s Magaall (" ¢ "alaiaY) kA ¢ "ard) A" Cliia) ga apand

Text o gl

B ool b ) R "aal) Gal audaga”c "oalll Gl ¢ Maipal) gl ¢ sl i "dig s Jaad”
2l d ) A el

Fit el

Nl SlaieY) ad G ¢S Magead) Gl ) ¢ Mand) A" ¢ i) el adga" e 3kl
Primary Units cu sl

oulia” ¢ (4 pdall ALalil) aay A V) aae) "ABAN Ag 2" ¢ Ayl s Al sl Cilas g "B " s
."P"""JS‘

sy bang Vo algh lad (i die sas g €0 ) o Joand e Y ) sl (ulie i dic
Alternate Units < gl

Aplal) las 5l 2al ) ddla) "y il gy dla)" el

Tolerance < il

Al DU "eslalad)" délia)

- £ "“. .

=AY laal gally das alanl Jaad ¢ 550

Y = ?@_.A\ u»\) S

Y = Xl dde FEEN

« = 48l 4a n <Decimal = Glas ) g5

& = 2l i g a plas )

Y JSal sl ALl 8 138 Sl daad aadiil

:/ :/ﬁ_ﬁ_ﬁ_ﬁ\;:

.

— s

s
Jall & glad

(YA Lo (e adaia a1 0l 5 (o ald) 138 ) "Chapter " aw ) cale =id) 1

LaY "Ribbon & &ll" e "Annonations &1 sa" cusd "Ml hal" ey ais 2
"Dimension ¢ si"

o) (s LaS "alag¥) Jaad paaa" )l sl g ye il 3
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‘| = = E} @ LI '|€§Dra&ing&hnnotation -r|? Autodesk AutoCAL
m Home Inset | Annotate = Parametric View Manage Output Add-ins  A380 :E’.uplm'Tm

%5 | Standard - Mystyle
P WSy
b |Find text 4y

Multiline :
Text  [A} 25

Text =

Dimensicn

[_]U—Cpifl[i Wireframe]

[4.52]

\ My Architectural Ihystyle
Manage Dimension Styles...

"yaa el Bl e el mse kil "New" Uil bail

Zladll Ll A"My Style" Sy "Mal) hai" aul al"New Style Name" Jisll & |

Susad) Ma ) Jaad cldial ga" ) sall & e lad"Continuo”
hsall age el 3 ke "hall) aul” ) LaaY

AgY) il Lascal 5 "Symbols And Arrows" sl sl e 6

GOy "agud) Gl aaa 2aail Y ) "ArrowSize" Jiall Acd sl "ArrowHeads" Adkiall
(o ) e Shoms

) size dad a5 Type Jaall & Mark g5l il CenterMarks for Circles 4dhiall &
Lleaaa g 38 jall Aadle g g5 aaadl (V)

OVl gl At Hl o gliall Ga"Text" sl sl |

"Ml pal gL paadl (0) ) "Text Hight"4esd Lav)

bi" e el Lo aiy Al Al aaadl (V) ) "Offset from dim line" Jéall dad laval |

_"d!..l.“

o

"Primary Units"—u sl 5 10
b L X"Linear Dimensions" ikl 11

58l Ry "alag¥1" 30510 "Unit Format" 48 il 4e3d) o "Decimal” & sl il e Kb

[ ]
A el

LA S b.olﬁ_)\ O Al s = ‘?GJ‘Y‘ 43y 1aail "Precision” 48 yidl Al e ()R e
A pdall )5S (1

b L 3"Angular Dimensions" ddhidl & o

Ll 530 (sl 20a] "Unit Format” 48 jid) ialill "Decimal Degrees” g sl Jlial (e X6 o
A pdall ) sl Arpay

O sS L’m\ﬁj BER A EN{PRTY LK "L g ?&Ji 432" yaal "Precision” 48 il Al (e (+) A8 e
A el suSl e A0S

"Ma¥) Jaad B lI" ) sadl aoje dgrd "alal) Jaad gl ga" ) sall aye Glad a8 g El 12
"Styles" ialdll & "myStyle" Jacill 4] Canal 38y ) gelall

Mladll halll" aleal "set current” ZUiell aaal 5 aaall ) laai lgal e X513
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dBaada
Cildaal go Jaanty e 1) Lol ALl il shaal) 3 7S5 "New" ¢ lidal) Jaal yaa "alag) Jaad iy el
Dsall wie s 4t Coglhadl "aa®) had" jidl e G 2 "Modify" Udell Laals laal)
Ao sthaall il sall (e sf Jaand (Sad ua ) slall "sad) Jaad Ciliial ga"
3l Jaad 30"l sall e (1] "Close” Zliall kil 14
(0 Ac sana iy pai 4 &3 Mg Liaa e W ol "Sgye" au )l cale dadal) Als ) oda 2 15
_"A.JA; ..11.1.)\ M"j N ERAL
o ailasll Alaniall Aalal ) | JSEN ans ) o5 Alladl) ABEAN" _a (+) A0a3) Jas e KB 16
(Addl) sl &5 el pale Cliial ga" Sl
MAladl) A4451" a "Dimension” 4addll Jxa) 17

"Ribbon &l e "aall 7 o e i P Ll | "aabadl) alati" ALl i 18
Al )l jelata
Ccmlnand: _dimlinear

Specify first extension line origin or <select object::

AV Al ) jelaid UL patel) "aad" s bl Jaad ") ~Uidal) larica i
-SE_'lect object to dimension:
Al ek (1) JSall mla gall Jaad) sl

Specify dimension line location or
[Mtext/Text/Angle/Horizontal/Vertical/Rotated]:

Zlikall Iaxal o ale Vo ) ga Adlie jluad) s Sl @ia | Maral) el a8 ga" s callai Al ) o3a
(<) JSal) b LaS a3l dalaiall ) axil) dad Calical 98 el ) () Jaa Dl 3 Al Y
-D]'.mension text = 48

+e———

oty S 5 "B paanall Sl A6 aadiin G (T4 )"l Al .19

. : , , R :
Al )l elaid | "Annotate () sal" w5l <"Ribbon du )" (1 LY baal e
C-:ummand: _dimcontinue

Specify second extension line origin or [Select/Undo] <Select::
dyijxd\asdy; &= Alad Rt Lghhj ugtﬂ\dxﬂ\ﬂjjglé.ﬁux>tﬁ (Y‘~)"dﬁ;ﬂ" palic (e palc L;idd;. °
ALl el e (A JS)
Dimension text = 28
Specify second extension line origin or [Select/Undo] <Select::

eV sy " p" bisl o
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el U725 G 0 ey o801 4 3 ) 2l il 5 0 Ay bl o) ilay

@S Gaadl e 2al)
Dimension text = 28
Specify second extension line origin or [Select/Undo] <Select::
O "R Al daaa) | " paieeal) dagd) B 1 el Ak paad allas ALl ol
slgi

Ay G shaall 2() Yo Ay gl 31 2" dilay 20

. - . ek . 2
jag}” C;ﬁ —-L;dyjaj\gga}ﬂ —-langﬂ\C}A4QSY\4QJQQY\J=aAJ:\ )
v| OheEdP S s-a '@Draitmg 8 Annatation Autodesk AutoCA
uhﬂihm-um Annotate | Parametric View Manage Output Addins A0  ExpressTo

-r|=

A #5F Standard -
S =
Muttiine & [Pt urrent - AT
Text 7 25
Text -
|
[~][Tep][2D Wireframe]
quiar
3 ates an angular dimensior
Tes mm DIMANGULAR
l&) Radius | Press F1 for more help
| I = —

. Rﬂa&dﬂ\ﬂ)@iiﬁ
Command: _dimangular
Select arc, circle, line, or <{specify vertex::
Select second line: <Snap off:
Specify dimension arc line location or [Mtext/Text/Angle/Quadrant]:
Dimension text = 135

ek (e 5 ,ally jailly) (o0 gandl Tadd) 23 (5 ) 311 amll " gY) Jad" o bl V1ALl e

s Al Al 5 jedaid Jolad) Jasd) i) ¢ g gl 30 amall " SEY Jadd" ppaas Callat AN Al )

ol Cilal 38 ali ) () Laadl Y OGN daln gl Aakaia)l i) "aad) el aB e aal
Aas)
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A1 S kil S gl a0 AT LY 21
A | D = E B @ (‘r'\] A ' = {C}_}Dzaﬁinghnnoion vv

ALrtUdesk AutDCAD 2m7 chapter 5 dlmensmns = dwg

A “5° |Standard ' - "_'| Mystyle - Iy ‘ /‘_)“ /-O Standard
e e | % :

Find text iy Use Current - :
Multiline R g\ Dimension g . 1 Center Centerline | Multileader /O
Tt T [B 25 At - Mark J8 5e
Text = £ | Dimensi Fl | Centerlines ! Lead

_[Wﬁrrépltzoﬁw&ef}rméejf ] | LT [ 11

451 Al elait "Ribbon dyddl" (1 T4 Y 3l e
l{-:lmnand: _centermark
Select circle or arc to add centermark:
AL Sl e Cancay gali ) o JaaBlis Jau) il Jama e ddaioas o
oY) G sall S pall Aadle " dilay Jaall )OS e

MY\ a_\\)j:;j\ .Js.a u.u.njs.“ "Jh.ﬂ‘ al Ja.a" fuL.A‘x' 22

] I '-._-Z';_'::. Annotate ric ": w  Manage
|
A #5° Standard v "_" Mystyle
Find text ;“E g Use Current
f'\-*lultilinev R : g\ Dimensicn g .
Text B 25 = i : =1 M -
Text = -

Linear
[ITopl[2D Wireffame] | |

e

Aligned | - -

i }Angular
fArcLength H—t—
®Radlus

T -
Dlameter =
Ryerrs-

|
. | Radius . ]
Malag" - 5l UA® Ly haal o
M) aBga" ada a3 i) Gesil o e Al s e
@y\du\‘;;dm‘;;wwﬁu"ﬂt g Ay o) i shall 5 e
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Al da e Jsanll "Save As" ial"File" 4@l e alal) ada a5 5aY) dls ) .23
JSE 3 90 e calad) e Blal) aa calall (e

Jaaual o3 Calall 138 Jaial Lad s s "Plate” (S5 Lol 5ia) "Gl Bha" sl w3 .24
MSave" Ll

"File" Aailal) (e "Exit" JLidl geali ll 30l oY) iS4 .25
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uad\.uﬂ M‘
gl g Aty

¢ all e ddlay) "eliadtal) s e Al e sladl) (e Al iy sl An ) ) (a3
Lﬁ;ﬂ\ "uaiaﬁ\ eu\"c "f-jel\ (sua\"c "4SJ.<5'J\ {y.u\" e C'_a\.o}],.a ‘;c_ Lﬁﬁ L_.ﬁm "QU\*.“ d\g.\;" ¢ ?)“J‘d\
G el o g N Al 8 e ) JaY) @iy ¢ ds W s

&) ALaYL el Y1 e Ao gane DA (e ALSH "AANAL Jaladf" alascinly ALK DSa) iyl )
Aeadiiall gl Gliial se daali (e 4 58l Ga piaill e 3 jlaall 4l

:Dtext

Oe uaall LUK S Ga OS Aol ol an )l Adls o SN (ai Gagga (o d e 13 aadid)
sl . ("Back Space” zUiall alasiul) LUSH LU G giSall "palll” Jhaed 401K ) ALYl ) skl
_";&SJV'CﬂlLJ\iaLQJ Jny\

Al jedat jeY) LN Nie

' DTEXT Specify start point of text or [Justify Style]:

-:Start point
238 (e el el ) bl (e oS dncal Y] AL (adl) UK o) | "padl) dglay AdalE" yaas
AV el ALl et Adasil) aaay ey "Adal3Y"
|
[~ DTEXT Specify height <2.5888::

Sufmob\k\ . "uaﬂ\djﬁ&mJ\" J.JJ;S;\SLJ:UL»)}\ 022

s:' DTEXT Specify rotation angle of text <@::

L Gail) s S (ies) el o G815 "Oall) i (Shaa )5 asant allat Al
IR ~Udal) dazical o Mia o) S|
Ui T ) A land) S ) (S0 aan s AS) lansll A5 5 yo IS jdipa" ) sels aa i
) sl Al
Justify, dﬁ!\ L";‘;);j\ Y
ALl el ol die | RS al chual 5 e 5 ] LAl 1 aaid

u_' DTEXT Enter an option [Left Center Right Align Middle Fit TL TC TR ML MC MR BL BC BR]: -

25 dae Al Gl LAT e el e Alli ) sda (g ¢33

[Align

ClS 13) ¢ AUS Ml el ) A "Cijad) anal ) Grindas cpilali o " palll AUS a8 ga" Jayas
(oSl s dadaiall Sl Cagpall 5SS "Galll e ST 3adal) dilaiall

Fit,

wae iy 3 (Sl jady o Gl g8 5) o) W) ety "al) A4S a8 ga" a3 4als (e Galadl jeY) s
bl o ol L o sl

‘Center,

QM@UE\%&&;M\‘;&NUEJM\ "JSJAS‘M" ‘;\J\AL_ALLUSI\)L“UJP&J)E
_4.):9.\5“ aill 5la
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:‘;_“&\ Ll all leania ¢ Sah "Badaal) Ada8" 1 A AUl e & 50 Aali (e due ) il LAl

TC (top center}

TL (top left)

; TR {top right)
ML {middle left) — X X _P/ . —MR {middle right)

BL (bottom lefl) — ——BR {bottom right)

MC {middle center)

B (bottom center)

'Style @‘-ﬁ‘ ‘5‘:)55\ ,)-“\2”
e aladin) die Gaae U e g sl 138 (5S o) any Awladin) oglladl) 20N Jad "( £.5) Jaad" clesind
Al ek LAl

[~ DTEXT Enter style name or [2] <Standard>:

e O seday Al "Jladl) UK Jaad" aladiul o A8 gall ey "JWA" Al e sl
Ay A,

[~ DTEXT Specify start point of text or [Justify Style]:
Moall Al AR naat Aals e o S g LS ALl ) & Jalzill NI

|~ DTEXT Enter text style(s) to list <*::

Gl a sl Cale 8 3 jaall Ja ghadll by Al sela ) (525 "B ALkl e aaal)

Height: @.@@88 Width factor: 1.886868 Obliquing angle: @
Generation: Normal

Style name: “"Standard™ Font files: txt
Height: @.8088 Width factor: 1.0888 Obligquing angle: @

Generation: Normal
Current text style: "Standard”
Current text style: “Standard” Text height: 2.5888 Annotative: No Justify: Left
Specify start point of text or [Justify/Style]: S
Enter style name or [?] <Standard>: ?
Enter text style(s) to list <*»:
Text styles:
__|style name: “Annotative” Font Tiles: txt
Height: @.8808 Width factor: 1.8808 Obliquing angle: @
Generation: Normal
style name: “"Standard™ Font files: txt
Height: @.@@88 Width factor: 1.8888 Obliquing angle: @
Generation: Normal
Current text style: "Standard”
Current text style: “Standard” Text height: 2.5888 Annotative: No Justify: Left

[~ DTEXT Specify start point of text or [Justify Style]: | e -l

LmdSuLaLucA_\A\j"habm J.:S\g_q.:)udbssw\".h\ghai\&\y\"w\sl\@)@m;u;
agall "Oaadl Jalea" ¢ Height(a sl &Ls.u\ dal e "dldal g 5 "haadll " Jad L?\l\}
el ¢ Generation:"(d g ) :\_.MS w" Cbliquing angle"(§ al) o Pla 4_“‘ w  Width factor
_Current text style"dw\ ;f\_)m‘ g e fujl,.,q LA:,\

bl e (FZ) C\Jé.d\ MJ&J‘M&SM\ il gladll @A;uajdu.ﬂ.ud\ 32804l eaiimﬁa.ﬁaj.a
Lelaal
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"Dtext" oY) alasiul e ooy paill 459 ol ghdll M
(Dl g " g pad) Ciual 5") a8V Caual il plasind 1

Command: DTEXT

Current text style: “Standard” Text height: 2.588@ Annotative: No Justify: Left
Specify start point of text or [Justify/Style]: 180,188

Specify height <2.50803: 5

Specify rotation angle of text <@::

¥~ al

Enter text  |Somir Hasam | Enter
| Enter text bCA_D/_CA_M _SE;R\{'IC_E _[:I—:_NT"ER _Ent_er _

Cpall a9 pad) (aual 5" 2

Current text style: “Standard"™ Text height: 5.8888 Annotative: MNo Justify: Left
Specify start point of text or [Justify/Style]: j

Enter an option [Left/Center/Right/Align/Middle/Fit/TL/TC/TR/ML/MC/MR/BL/BC/BR]: r
Specify right endpoint of text baseline: 2@@,7@

Specify height <5.0808>:

specify rotation angle of text <@::

- | |

:Emer text jgdmip HO\SQI’H . . Enter
| Enter text .CP‘_D/_CH_M __SE:_R\{'IC_E _CENT‘.ER | Enter

"Align" Slall e\;s_m\ 3

DTEXT

Current text style: “Standard”™ Text height: 5.8880 Anncotative: No Justify: Right
Specify right endpoint of text baseline or [Justify/Style]: j

Enter an option [Left/Center/Right/Align/Middle/Fit/TL/TC/TR/ML/MC/MR/BL/BC/BR]: a
specity first endpoint of text baseline: 27@,17@

Specify second endpoint of text baseline: 318,178

Enter text  |Samir Hasam | Enter
Enter textt |CAD/CAM SERVICE CENTER  Enter

Gy alatia (S5 Cag all jieaaly a8 el jll (S1g 303aall dihid) (e ST OIS GQgiSall Gaill (o)) JaaY
gl ¥ i a3y "digoall s e Jla ol melinll o) ) Ay cpiadaal ihdll G Caal
303l dalaidl e Talaie)

"fit" Jball alaatiul 4

Command: DTEXT
Current text style: “Standard” Text height: 5.8888 Annotative: No Justify: Align
Specify first endpoint of text baseline or [Justify/Style]: j
Enter an option [Left/Center/Right/Align/Middle/Fit/TL/TC/TR/ML/MC/MR/EL/BC/BR]: T
Specify first endpoint of text baseline: 278,148
Specify second endpoint of text baseline: 316,140
Specify height <5.@0883:
Enter text .SOJ"]”’“ HCLSQKW . Enter
| | e [CAD/CAM [SERVICE CENTER emet | |
e Aailadl) a) Cig all akay &8 el yll (815 s03aal) dshiall e ST O S Gaill ) JaaY
Ol Gpiladill fpa Lgmia g g (<o g adl daal) o las )
. aaada
Giiball e lalaie) et "Width Factorcisall oa sl Jalaa” 8 "fit" o Al JLall aladin) e
ena "Jalaall" 138 dagd ()ld 303aal) Ahaiall o ST (il Cag ga ailS 1) Mpall) dllala" Cay il (piindall
(V) o
style
LAl e cilidg s "gpma Bad LAl Sl e Jad Jaal" oy el 233505 ealiall Al sl sY1 (e sa
Y ) sall & e )ty ot Mie ."DteXt")*;)j TN = A
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@ B
e Text Style e —- ]
Current text style: Standard
Shyles: 2
ort
A Font Mame Fort Style
= bt sho -
& New...
[] Use Big Font
Size: =
[ Amnotative (&) Height
Match text orientation 0.0000
to layout
[ siytes s
[ Upside down Width Factor:
1.0000 i
[ Backwards
I Q b Oblique Angle:
i T [Evetical 0
I
i Apply Cancel Help
§
= J

o LS5 a8 Jaad oL e i e ) sall g e pladiuly

B New Text Style »

Style Name: IM | I OK I

Mty eters SEL gl 3 -2

A Texdt Style

Curment text style: MyShde
Styles: -

A Annotativ%

MyStyle

Standard ‘du\ ‘.; e‘“y\ \..JA J}G_L h)\:\é

MRS Bl ) s o

Font Mame:
2=i"Times new Roman" () siall a5 44l jial) daildll ) [ bt shx M & -3
.uhﬂ‘ &Jsu

Fort Style:
Jaal'ltalic” Jball Lad 84 3w igall Jeal"Bold" sl Jisll i -4
el cag all Jzay"Regular” Jball Al s dSpan Ca g ya LY "Bolditalic” Jball s dlile o yall
Aalie V) Leillay
Height
vie "hgad) pUE" o b plasll jhaall 4 s "l YI Aedt o i OO0 Jiall b -5
g all it gl g Tadd) iy Adlide (a geai LS dplSa) Uy 5 A0S
IS Laa 5 LAl (e ol Tl oy all Lgtilal (S il <l Jle"Effects” dikiall sl -6

Ao Bl
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80 adde il sl Ax g3 e Caud (8 o e o slhaall "haalll amd” e dil "AUSY Jaad " il -7
Mam) Al ek ) Jiig (F2) Uikl Jaral & 3asl

sl g gt (G5 ] y 5 ach Jladl) Beail a3 (el [ S | gy g
+ Gilaadla

Al 2REn) (52 " Jaad" (i e die Lo Undi "AUSh Jaa® J)gn moje 00 ALl 0 e
Lt e maa Ui 138 8 LUSH aail a0l 13) Ll ¢ Jaaill 138 i 48] T 5

¢ 5 Taaill Ll "pxt.shx"Jie "olad¥) AU A8 baad" ia) vie Lo Uiy [JVeted oy o<, o
L e maar LAl 138 QU "

il LaS g 13 AUt Jaad alasiind e i oY)

Current text style: "Standard” Text height: 2.5888 Annotatiwve: No Justify:

LV @S |- DTEXT Specify start point of text or [Justify Style]: ?‘“’)M Laks e adass A;;

Specify height <2.5666>: 8
Specify rotation angle of text <@>:

| Command : "ENTER TEXT "MY FIRST TEXT STYLE"
 Command.: "ENTER TEXT Enter

D (oAl

"rotation angle = 15" dadll i aa 51 25 7S

Y e Ay V0 Aol Jaa aleSh "Galll e ) JaaDli

ddaada

e padiud g li Yl 1 b "GUSH Jaa" ) sl 4 ye 3 (Hight) LUS daai Cog yad "B L )" aaas 2ie
Sl Jaad Sl sall o e 8 Capall g LY sadaall Aall CuilS Laga "aad) al g pa S LS )" 4l
text !

"Dtext" y¥! 43l L 5 daladinl b Lla 4y

Mtext Y

ALY (a e "Basie s AESD eV 138 aadid

Al jelas 5 1 28w e

Command: mtext

:  "Standard" Text height: 2.5 Annotative: No

AV Al N jedad Glld amy | il a8 sl " gV ABARE" yyan ks Al 1) 028

acing/Rotation/Style/Width/Columns]:

m MTEXT
@LASBJ;}R:\ABJ&\.\ J}@.LJ:A)\S Jﬁa}.«]\ :\SJAGA ua.d\ cﬁ}nw"gﬁm‘ OSJS‘" Ag&dﬁz\ju)l\ 0d
r ) JLal
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e

o

Sl 3 el LS oall) 5" s "Ribbon B pdll" e cusi el "gisall iy 3 e sl 2n,
a\.'mi

press

Perfarmance

nd N

Formatting ~

Drawing1*

[~1Top][2D Wireframe]

‘ &, L"m‘.\".\m\m\.‘m‘m‘.\".\‘.m.w.wm.mw‘|H.w.|
I 7|

"Cilhal gall” e b hall ANA e (Sad s "pageal ) a8 sl 13 Gaa 58l )5V aadid

AL Akl & "galll” g lsall a e ) 3 gthad) Gatl) CS) il Ca gyl Adlinal)

Luaail)

Jie dilia) cululSa) 138 "Gail) e cuy il 35
@

Find &
Replace

o oY) A<y
CiSall aill Gana 5 AT Alan ol Al Lellaiind 5 dime dlen ) S (o "Gl 1 LAl 13 aadiug
oaill sk o "Alaldl) bl e 5l
A it
0 [ Bylayer

Formatting - Zﬂl:d\ 2\.1.115.«‘){\
(O3 A5 3) 5 (Banaall) ¢(Lmall) Cua (e "padll g e Cliual ga” e 3 k)
@
R Sl ) Alsay)
all dadle ) ¢ (A siad) s all) Jia ) A "dald " Adlia) Ay : Liaall 13 ozl
D S ! ! AR
"Laldl) jga i Crala e g
oad 3 i)

Symbol Field | Spell|  Edit

Select All

[=][Topl(2D Wireframe] Cut CirleX.
Copy s
Paste CtrleV
Paste Special >

Insert Field... Ctrl+F
bl >‘,_“M
Import Text... N ‘

o 5iSa "Gl A el s rany dlall AN (e "l A il LEA) & Gaill dalae e el i)
Apdall e AT g s
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AUl pUndl Cu gual
OSad Al oda ¢ e e elgi) J8 Wasdl sa Jo¥) £ gl | "eUadYI" (e e g5 Cadlal O (Sl
Uadll (gl iliall 4a 5l & "Back Space” zliball alasiu
LeS 5 Uadll oy aaail "aaibiad™ ) aadind Allall o 8 ¢ YY) 2850 (e elgiV) any Uadl) g ALY £ o)
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